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GETTING STARTED

4DM Personal’s Patient Browser is the front-end to 4DM Personal, which
is used to load patient data into 4DM, and it provides an intuitive file
management interface for data access and management. Users can receive,
export, and query/retrieve DICOM part 10 image files through DICOM
connectivity to network connected workstations. The patient browser

provides DICOM file import and export capability to local and network

directories. The patient browser permits the user to filter, edit, and select
the data to pass to an application (e.g. 4DM).

4DM Personal’s Patient Browser is a comprehensive data access, transfer and file management system
for medical imaging data. Its simple and intuitive interface provides an environment where users can
perform a variety of image file management operations such as store, import, receive, and transfer files
between local, shared, and DICOM nodes and perform DICOM Query/Retrieve operations.

Finally, the patient browser provides a gateway to 4DM — an advanced visualization, quantification, and
reporting software solution by selecting 4DM from the patient browser’s application panel.

You can use the patient browser to do the following:

= Receive and store DICOM image files sent by remote DICOM nodes to a local or network
connected database or directory.

= Receive Pegasys file formatted images stored to an SCP directory and convert them to an INVIA
native DICOM image format.

= Receive ECAT file formatted images stored to an SCP directory and convert them to an INVIA
native DICOM image format.

= Automatically import DICOM image files stored within a defined directory.

= Query/retrieve a list of DICOM image files from remote DICOM nodes to a local or network
connected database, or a directory.

= Export DICOM image files to local or networked databases and/or directories.

= Export DICOM image files to a remote DICOM node supporting DICOM store.
= Export DICOM image files to external media (CD, DVD, and USB drive).

= Manage multiple databases and/or directories to organize patient data for review.

= Set a search filter for a database or directory to display data based on Patient, Study, and Series
information in the DICOM file.

= Edit DICOM image files to correct user input errors.
= Access 4DM Reporting to edit an existing report.

= Merge two patients into one.
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More detailed
instructions for product
installation can be found
on the Training and
Support pages at
www.inviasolutions.com

Throughout this guide, INVIA will rely on consistent use of terminology and symbols to best communicate

with you, the end user. Below is a summary of these conventions:

= Blue, underlined text represents links to help you quickly navigate within this document or

launch online content (Internet access required).

= Helpful hints, warnings, and additional information, which appear in the left margin for quick

and easy reference, are identified by various symbols:

/ Note

. . Right Click
! Warning & Tip

Option

The User’s Guide and user interface will rely on the following abbreviations:

Operating Systems:

Abbreviation Description

AE Title Application Entity Title identifies the DICOM nodes communicating between
each other.

DICOM Digital Imaging and Communications in Medicine (DICOM) is a standard for
handling, storing, printing, and transmitting information in medical imaging.

1P Internet Protocol is a unique identification number, such as 127.0.0.1, for
devices (computers, printers) within a network.

SCP Service Class Provider

SCU Service Class User
oo 65 e

Supported | Windows 8 (64 bit)"

Windows Server 2016
Windows Server 2019
Windows Server 2022

Windows 10 (64 bit)
Windows 11 (64 bit)

Speed: 2.0 GHz or greater

P :
rocessor Cores: 4 (minimum), 8 (recommended)
8 GB (minimum)
Memory:
16 GB or more (recommended)
. 512GB or larger NVME hard drive (recommended)
Disk Storage:

NOTE: 2GB is required to install application.

Video Card:

256 MB of on board Video Memory (minimum), 1 GB (recommended).
3D graphic card supporting OpenGL 3.0 (minimum) or greater (4.1
recommended)

Monitor:

Up to four HD (1920x1080) monitor(s)

'These operating systems are not recommended as they are at or nearing end of life.
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http://www.inviasolutions.com

The Licensing window
can also be accessed
from the Windows Start
Menu. Select INVIA and
then INVIA Licensing.

Left-click About from
the Help menu to review
the patient browser’s
product information, a
summary of licensing
information, and to
access this User’s Guide.

A O

Close any previous versions of the patient browser and 4DM that are open.

Insert 4DM Installation media into the computer or server.

If the media does not autorun, open Install_ 4DM.

Click on Install 4DM.

Follow the on-screen installation instructions.

To launch the patient browser, select 4DM from the INVIA tab in your program list in the

Start Menu.

In order to run 4DM Personal, you must have a valid license key. The application supports both fixed

and floating licenses. To open the Licensing window, select 4DM Licensing from the INVIA tab in your

program list in the Start Menu. Users have the option to select the site-specific license model type. The

fields within the Licensing window will change based upon selection.

Fixed License Model (Figure 1.1)

(2]

Hardware ID: This is a unique identifier
specific to the workstation to which 4DM
is licensed.

File Location: When licensing a fixed
installation, the user can navigate to the
directory folder where the 4DM fixed
license key file is located using the folder
icon. Once the Check Status icon is
selected, 4DM will automatically copy
the license file to the 4DM application
directory and display the file path.

Status: Displays any messages regarding
the validation of the license key file.

Available Features: Lists the features
defined by the license key.

Floating License Model (Figure 1.2)

Users can choose between the IP
address and the Hostname to connect
to the server/workstation where the 4DM
license manager is installed.

IP Address/Hostname and Port: Users
enter the IP Address or Hostname for
the license manager. Select the Check
Status icon to verify the connection to
the license manager.
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Figure 1.1: The Licensing window - Fixed License
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Figure 1.2: The Licensing window - Floating License
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©® Server Information: Displays the active license manager address or hostname, the total
number of licenses on the license manager, and the number of licenses in use.

@ Status: Displays any messages regarding the validation of the license key file.

© Available Features: Lists the features defined by the license key.

Floating License with Backup Model (Figure 1.3)

@ IP Protocol: Users can choose between
the IP address and the Hostname to

= ®

e . '0 nbaam & valiel hoense, send a FRqEes! b6 your sairs

connect to the server/workstation where Lo T [T e
the 4DM license manager is installed. ,.\,,sw:.v:,‘:o = e 57 ]
(2] Primary IP Address/Hostname and e

Port: Users enter the IP Address or
Hostname for the license manager.

Gastes

Select the Check Status icon to verify At e
the connection to the license manager.

©® Backup Server IP Address/Hostname 2
and Port: User enters the IP Address

or Hostname and Port number for the Figure 1.3: The Licensing window - Floating

. . . License with Backup
license manager that is designated as the

backup server. Select the Check Status
icon to verify connection to the backup
license manager.

@ Server Information: Displays the active license manager address or hostname, the total
number of licenses on the license manager, and the number of licenses in use

© Status: Displays any messages regarding the validation of the license key file.

(® Available Features: Lists the features defined by the license key.
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CHAPTER 2 | NAVIGATING THE PATIENT BROWSER

For help retrieving files This chapter guides users through the basic features and functionality of 4DM Personal’s Patient Browser
from remote DICOM while accessing patient files from local and shared directories.

nodes, go to Chapter 4:

DICOM Configuration.

First, the user should become familiar with the application’s user interface (Figure 2.1 ). The menu bar at
the top of the interface includes the File, Tools, and Help menus. The interface is designed to flow from
left-to-right, with three areas: Sources, Search/Patient List, and Applications/Destinations.

= Sources — The left side of the patient browser interface provides a list of data sources.
Navigate local or shared directories within the Local tab and DICOM-connected
workstations within the Remote tab to access patient datasets. Add local and DICOM
folders and databases to the Sources panel for easy access.

= Search/Patient List — The center area of the patient browser interface allows users to
filter imaging data by applying search parameters or by prioritizing according to file
characteristics. Select one or multiple items from the patient list for review or transfer.

= Applications/Destinations — The right side of the patient browser interface applies actions
to patient files. Launch a patient file in 4DM for review, make edits to DICOM attributes,
merge patient files, or copy files to local or remote destinations.

Sources Search / Patient List Applications/

Destinations

E

£

o —

oo T

Figure 2.1: The patient browser screen contains File, Tools, and Help menus, and three areas for user interaction:
Sources, Search / Patient List, and Applications / Destinations

Menu Bar

The top menu bar contains File, Tools and Help

File | Tools Help
File (Figure 2.2) Exit

= Exit: Exits the patient browser

Figure 2.2: File Menu
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You can load studies

from multiple sources

at the same time. The
& patient browser will load

studies from each source

that is selected.

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE

Tools (Figure 2.3)
= Database Manager: Described in Chapter 3

= Local SCP Configuration: Described in Chapter 4

DICOM Node Configuration: Described in Chapter 4
= Job Queue Manager: Described in Chapter 2

= Preferences: Described in Chapter 5

= Auto Import: Described in Chapter 4

Help options (Figure 2.4)

= About: Provides patient browser product information,
Language Setting, License Information, Feature List and
User Guide button

= Event Viewer: Described in Chapter 4

Tools] Help

Database Manager

Local SCP Configuration
DICOM Mode Configuration
Job Queue Manager
Preferences

Auto Import

Figure 2.3: Tools Menu

Help
About
Event Viewer

‘Watch 4DM Personal's Patient Browser Log

Figure 2.4: Tools Menu

= 4DM Personal’s Patient Browser Log Viewer: Described in Chapter 4

Sources

The installation process creates a default database on your local drive and loads sample files to a folder on
your system. These two locations appear as shortcuts in the top left panel of the application (Figure 2.5).
To browse for local folders with stored DICOM files, simply navigate to the desired location using the
folder structure directory in the bottom panel of the Local Sources tab (Figure 2.6).

To Select Local Data Sources

Local |Remute| L\%

Sources

e = 5| Wy Computer -
i r(i %n lﬂ =8 _=| System (C:}
- = =7 Public
[0 B Database: default ] Deskiop
® T CoProgramData\DocumentsUMNVIACorridordDMSampleData B -zl Documents
27 mvia

© &7 corridor4Dnt

=7 4DMOpenGL

1 _=| colorbars

1 _=| local

1 _Fl reportFinal

4 _=| reporfTemplates

= B

Figure 2.5: This area displays shortcuts to local folders.

= Click on the desired database or directory

(Figure 2.7). Click the Refresh

| W | CisersiPublicDocumentsiby1ACoridor 40 SampleData

tool (Figure 2.8) in the Patient
List Panel to display a list of

Figure 2.7: Selected Local Source

. Patient List
patient files.

%

1

A

)| N

Figure 2.8: Patient List Panel

Figure 2.6: An example of the folder directory panel.
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Save time when loading
studies — put your most

& frequently used databases
and folders in the
Sources menu.

Search parameters are
not case sensitive. A
/ search for ABC will

return the same results as
Abc or abe.

Search Parameters and
use of the Wildcard (*):

= abc — Returns items
that exactly match

%3 tH)

abc

= abc* - Returns all
items that match the
characters before the
asterisk (*); all other
characters are ignored
(e.g., abe, abed, abede,

& etc).

= *abc — Returns all
items that match the
characters after the
asterisk (*); all other
characters are ignored
(e.g., mabc, nabc,
oabc, etc).

= *abc* — Returns all
items that match the
substring “abc” (e.g.,
abed, dabe, fabeg,
etc.)

= Local Refresh is done automatically for patient datasets at each level: patient, study, and
series. The patient browser also auto-refreshes the sources for patient datasets in local mode
on start-up, on new source selection, when importing, copying, deleting and auto-importing
4DM result files into database.

To Create a New Source Directory

= Click the Add Local tool (Figure 2.9). Select the = —
desired directory and click OK. The new Directory lﬂ

Figure 2.9: Add Local tool in
Local Sources Panel

will appear in the top Local Sources panel.

To Navigate to a Local Directory (local or mapped drives)

= Navigate to the directory and folder of your choice. Click on the desired destination so it is
highlighted blue. Click the Refresh tool in the Patient List Panel to display a list of patient
files.

Search/Patient List

The center of the patient browser interface provides the Search panel and Patient List panel.

Search Panel

The Search panel (Figure 2.10) can be used to search a large database for patient studies. The search
criteria can be set by Patient Name, Patient ID, Study Description or Series Description in the default
view. The Show Additional Fields button will expand to permit searches by Modality or Accession
Number.

Enter the search qualifiers into the various text fields and then click the Refresh tool in the Patient List
panel. For examples, see the Tip in the left-column.

—Search

Patient Mame: l:l Study Description: | | L’\;\
Patient 1D l:l Series Description: | | J

Study Date: |All Dates v |13 Sep o024 and |13 Sep T

Figure 2.10: The Search panel in its default state

The only field that is not text based is the Study Date. This field uses a drop-down menu to set the
parameters for the search and a pop-up calendar for date selection (Figure 2.11):

= All Dates: Query does not restrict returned files according to dates.

= On: Query will return only studies performed on the specified date.

= Before: Query will return only studies performed before the specified date.
= After: Query will return only studies performed after the specified date.

= Between: Query will return only studies performed between the two specified dates.

l’:?tudyData: iv] Mar *||2012 | and Mar x| (2012 -

All Dates.
On

‘;x E BEfDrE E
i At
E ST — 2

me

Today

al Yesterday Most Recent S...  # of Studies Location
tﬂsﬁ BE‘IS 22-May-2007 1 C:\ProgramData\Documents\INVIA\Corr
ic2 S s | osMar-2007 1 C:\ProgramData\Documents\NVIAICort]

Figure 2.11: The Study Date area includes a drop-down menu of the various parameters
for a Study Date search and drop-down menus for day, month, and year.
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The patient browser will
conduct the following
date-based searches
according to your
computer’s date setting:

= Today

= Yesterday
= Last 2 Days
= Last 7 Days

The end user has the
ability to copy/paste the
patient list into other
applications such as
MSWord, Notepad, Excel
and other documents

that support copy/paste
of text.

By default, the file list
will be organized by the
Patient Name column,
starting with numerical
file names and then
alphabetic file names.

When a patient or
multiple patients are
selected, the Study,
Series, and Instance
Views will apply only to
those selected patients.
Return to the Patient
View to see all available
patients.

Today: Query will return only studies performed that day.
Yesterday: Query will return only studies performed on the previous day.
Last 2 Days: Query will return all studies performed within the past two days.

Last 7 Days: Query will return all studies performed within the past seven days.

P rienre 212
Click the Reset tool (Figure 2.12) to clear all fields. I;_I:] Figure 2.13
eset tool

Patient List Panel

The Patient List panel displays available files from the selected source(s) or source location(s)
(Figure 2.13).

A Patient Name

Patient ID Most Recent S...  #of Studies  Location

4DM GBPS,001 004-018,GBPS/ILAD (MUGAZ) 20-May-2009 1 C:A\Users\Public\Documents\INVIAVCorridor4DM\SampleDatal...
4DM PET CFR,004 003-003,RB&2+CFR (CFR4) 28-0ct-2009 1 CAUsers\Public\Documents\INVIA\Corridor4DM\SampleData...
4DNM PET, 001 004-014 RB32 (PET Abnormal) 02-May-2008 1 Chlsers\Public\Documents\INVIA\Corridor4DIMMSampleDatal...
4DM SPECT, 001 004-001,10 GS/R (lschemic2) 09-Mar-2007 1 CAUsers\Public\Documents\NVIA\Corridor4DM\SampleDatal...
4DW SPECT-CT,001 004-003,10 GS/R+CaSc (CaScy  22-May-2007 1 CUsers\Public\Documents\INVIA\Corridor4DM\SampleDatal...

Figure 2.13: Patient List

This area contains five User Control tools (Figure 2.14) and four File View tools
(Figure 2.15):

Refresh (Double Arrows): Populates or updates the list with files from the
selected source as filtered according to the search parameters.

Stop Refresh (Double Arrows with Hand): Cancels the patient list update
action initiated by the Refresh button.

Select All (Cursor Arrow with a Check Mark): Selects all of the displayed
patient files within the patient list.

Unselect All (Cursor Arrow with a Minus Sign): Deselects all of the
displayed patient files within the patient list.

Delete Selected Dataset(s) (Trash Can): Deletes the selected file(s) from the
patient list and the source directory.

Patient (Person): Displays Patient Name, Patient ID, Most Recent Study
Date, Number of Studies, and Location within the display list.

Study (Scanner): Displays Patient Name, Patient ID, Study Date, Study
Description, Modalities, Number of Series, and Location within the display
list.

Series (Single X-Ray): Displays Patient Name, Patient ID, Modality, Series
Date, Series Description, Number of Images, and Location within the display
list.

Instance (Two X-Rays): Displays Patient Name, Patient ID, Modality,
Instance Date, Instance Description, and Location (only available within local
mode).

By clicking on the column header in the Patient List panel, the list will sort according

to that field. The sort order is designated with a small black triangle. A single click will

organize the information in ascending order, and a second click will reverse the order.

The columns can be resized by clicking-and-dragging on the column border.

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE
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Figure 2.14: User
Control tools

2

LT

=

o

Figure 2.15: File
View tools
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Select multiple files

at once to save time.

Hold the shift key while
selecting the first and last

& in consecutive list. Hold

the control key [Ctrl]

while selecting multiple

inconsecutive items.

WARNING

Changing Patient Name,
Patient ID, Birth Date,
and Gender can affect

[ B )

diagnostic results.

Applications Panel

The functionality to apply an action to patient files is located in patient browser’s right panel. This panel
is divided into two areas: the top half is the Applications panel providing button controls for launching
additional applications; the bottom half is the Destinations panel providing file transfer capabilities.

4DM

To open desired files in 4DM for study review, the user simply needs to select the specific files and then
click the 4DM button in the Applications panel (see @ Figure 2.16). If the user selects a patient that
does not contain patient images, clicking the 4DM button will open 4DM Reporting.

The user can edit the command line to select a

BEST Command Line A

specific user workflow to always launch when
the 4DM application button is selected, e.g. -user Al tans oty el

. . . . . Command Line Arguments:  -user DrSPECTReview
DrSPECTReview. Right-click on the 4DM application
button to launch the editor (Figure 2.17). This

command will launch 4DM with the user configured Figure 2.17: Right-click to access the
Command Line Window

[k [ comea ]

workflow until it is deleted from the Edit Command
Line Arguments field.

@ VP BroniaPFenow) v e =

| i o i oo i V95 Lk s i S [ Fafamn t (Fo Sam i (i e | [l napmen §

Figure 2.16: Select files to open in the browser window

DICOM Editor

The DICOM Editor is accessed through the Application Panel (see @ Figure 2.16). The DICOM Editor
(Figure 2.18) can be used to view patient DICOM information, anonymize patient data, review entire
DICOM attributes and edit DICOM attributes in the selected file.

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE CHAPTER 2: NAVIGATING THE PATIENT BROWSER = 9



The check box

for Anonymize
Miscellaneous
Information is
deselected by default.
If selected, it will
anonymize multiple
miscellaneous DICOM
fields including:
Institution Name,
Institution Address,
Referring Physician
Name, Patient Insurance
Code, and more.

To load a patient into the editor, [EeE

select it from the Patient List and | ™%

click the DICOM Editor button
from the Applications panel.

To Anonymize a Patient Name:

= Select Anonymize Patient
Name (Figure 2.19)
— When the button is
activated it will clear
the First Name, Middle

Fisthame. o
Miode bame. [
LastNama: [wsmecr
Prefoc [
Seffoc [

Ap [
Bt Date: [ =] [ =] e =]

1D Mumber. [004.501.10 GER (shamel i
Institution Name
Haghtiem) Gandar

weightteg [ & Male  Famale
Accession Number. [1136s —  Cabae © Undefined

™ Anonyrize Miscellansous Ifoemation

Foaview Entirs Fila

Seloct Series 1o Edit =

Save Cancel

Name, Last Name, Prefix
and Suffix fields. The
Last Name field will display ANON
followed by the first three characters
of last name and the first character of
first name. (i.e., John Doe becomes
ANONDOE]J)

To Anonymize a Patient ID:

= Select Anonymize Patient ID

(Figure 2.20)

— When the button is activated it will
clear the ID Number field and then
display ANON followed by first four
digits of ID Number followed by
date and time on system at time of
edit. (i.e., ID NUMBER is 12345678

Figure 2.18: DICOM Editor

—File Export Settings

Anonymize Patient Name ™ Anonymize Miscellaneous Information

Anonymize Patient ID |

Review Entire File |

Figure 2.19: DICOM Editor - Anonymize Patient Name

—File Export Settings

Anonymize Patient Name I Anonymize Miscellaneous Information

Anonymize Patient ID

Review Entire File

Figure 2.20: DICOM Editor - Anonymize Patient ID

edit occurred on 9/8/2009 at 12:12:12pm, becomes ANON123420090809121212)

To Review DICOM file:

= Select Review Entire File
(Figure 2.21)

= A text file will open in Notepad listing
the DICOM attributes for the selected
dataset

= Displayed fields are not editable

To Edit DICOM information in a selected file:

= Choose a field you want to edit

—File Export Settings

Anonymize Patient Name ™ Anonymize Miscellaneous Information

Anonymize Patient ID

Review Entire File

Figure 2.21: DICOM Editor - Review Entire File

— Editable fields are indicated by a text box and allows free text editing

= Click Save to overwrite the original file passed to the editor or Cancel to exit without edits

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE
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If the patient is located

in a Database the
Overwrite option is

disabled.

4DM PERSONAL'S PATIENT BROWSER =

To Generate New Patient from a selected file:
= Edit the Patient Name or Patient ID
— The New Patient button is now available

= Click New Patient to generate the newly defined patient with a copy of all other DICOM
fields loaded into the editor

Merge Patient

Merging a patient consolidates two patient records into one, in the event that a duplicate has been created
in error.

Two example use cases of the Merge Patient functionality in the patient browser are:

1. If auser created a preliminary report within 4DM Reporting for “Jon Smith” (incorrect
spelling) and then later imported a patient named “John Smith” (correct spelling) from the
worklist and acquired patient images.

= Two patients would be created since the names do not match.

= Merging Jon Smith’s preliminary report into John Smith’s image data would create a
single patient that contains both the patient information as well as the patient images.

2. If patient images were acquired under the wrong patient entirely — e.g., the user selected
“Jane Smith” from the worklist and acquired patient images, when the user should have
selected “John Smith.”

= Two patients would be created since the names do not match.
= Merging Jane Smith’s patient images into John Smith’s patient file would reassign

the images to the correct patient.

To combine two patients into one, select both patients from the patient list, and click Merge Patient
(Figure 2.22). In the Merge Patient window, select the Up arrow to merge Patient 2 into Patient 1, or
select the Down arrow to merge Patient 1 into Patient 2.

P S E .

Saay taw TR - i

Bl=EE

e ]

Use these controls to merge two patients into a single patient.
Patlent 1
Patien! Name Patien I}
John A Smith 00400110 GER (lschemic2)  Male 13-4dar- 1954
Patient " ]
Patient Hamea Patiant i F F
Johin Smit 004-001,10 GIR (lschemicZ)  Male 13-Mar 1854

Figure 2.22: Merge Patient tool

During the merge, any DICOM datasets from the other patient is added to the master patient. Note that
DICOM datasets are always added to the master patient, never overwritten.
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The patient the user merges into will dictate the Patient Name, Patient ID, Gender, and Date of Birth
that the patient retains. All other demographics and medical history information that are retained will be
taken from the more recently saved patient information.

A pop-up window allows the user to delete or keep the secondary patient. Note that, during the merge,
the user will not have the option to select which fields to keep or overwrite.

Destinations Panel (Figure 2.23)

To copy patients to a database:

= Select specific patient files

= Select the target database
= Click the Copy To tool (Figure 2.24)

Destinations

el ol

To copy patients to a DICOM node:

O B Database: default

= Select specific patient files [0 3% DICOM: Clinic

= Select the target DICOM node

= Click once on Copy To tool Figure 2.23: Destination Panel

To copy patients to a New Directory: = Figure 2.24: Copy To tool

= First, create a new directory
— Click the Add Local (Figure 2.25) button __
— Select the desired directory ) Figure 2.25: Add Local tool
— Select OK

= The new directory path will appear in the Destinations panel
— Select specific patient files
— Select the target directory

= Click once on Copy To tool

The patient browser interface provides a Status Bar along the bottom of the patient browser screen. There
are five display panels on the Status Bar (Figure 2.26):

[9ob Gueve - Active Jobs: 0, Completed Jobs: 0. Last Job Status: Unknown [&of Pending Results; 10 |dof Patients: 5 [of Studes: 5 |G of Senes: 5 & of Images/Instances: 5

Figure 2.26: Status Bar

Right-click on the status
bar to display the last 100 = Job Queue: The number of Active Jobs and Completed Jobs will be displayed in addition

actions in a window. to Last Job Status. If an error occurs, the Failed status window will be displayed and
provide the reason of failure.
— Left-click on the Job Queue to view the Job Queue Manager.

= Job Queue Manager: Displays Status, Timestamp, Type and Details for both Active Jobs
and Completed Jobs.
— Active Jobs: The user can View Job Details, Move Job Up, Move Job Down, Cancel Job
and Pause/Resume Job in the Job Queue Manager.
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— Completed Jobs: The user can View Job Details and Delete/Clear All jobs in the Job Queue
Manager.

= Action Status: Displays Copying actions.

* Number of Pending Results: Denotes the number of DICOM result files from Corridor4dDM
pending import into a database.

= Number of Patients: The number displayed depends on the Patient Display List
— Displays the total number of selected patient files.

= Number of Studies: The number displayed depends on the Patient Display List
— Displays the total number of selected study files

= Number of Series: The number displayed depends on the Patient Display List
— Displays the total number of selected series files

= Number of Instances: The number displayed depends on the Patient Display List
— Displays the total number of selected instance files. (Only available on the Local tab. On the
Remote Tab, the display panel is always blank.)
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CHAPTER 3 | DATABASE MANAGEMENT

The Database Manager window (Figure 3.1) is accessible from the Tools menu and permits the user to
add and delete databases as well as manage database files.

Databases have an
advantage over folders
when it comes to patient
file storage. Queries
return search results in
less time. Also, users can
efficiently add and delete
files.

If All Studies Older Than
a certain number of days
are selected, comparison
studies that are older
than the defined day
range in the database will
be deleted during the
Database Cleanup Time.

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE

Location and Type (local or network). Left-click to access the

following database tools (Figure 3.3):

@ Test Database Connectivity: Tests the connectivity between
the patient browser and the selected database. This is useful for
troubleshooting issues with networked databases.

@ Database Cleanup Schedule: This tool provides a window where the
user can define an automatic cleanup schedule to reduce the size of an
image database. Within this window, the user can define the time the
scheduled cleanup will occur and the criteria for which files are to be
deleted when threshold limits are reached.

© Rebuild Database Index: Reconciles the number of database entries
with the number of files.

@ Compact Databases: Reclaims wasted space within the databases and
improves performance.

© Database Auto-Routing Schedule: This tool provides a window
where the user can specify a DICOM destination where images will be
automatically transferred. This is primarily used for pushing results to
a PACS system. For each database, the user can specify one or more
destination DICOM nodes (Auto-Routing Nodes), a start date after
which all image files will automatically transfer to the destination(s),
and the schedule time when the automatic transfer will occur.

£ Database Manager *
n] Name Size (MB) Entries Clean Up Schedule Auto-Routing Status
default 0.04 3148 Never Delete Newver Auto-Route Up to Date(10}
E ini Never Delete Never Auto-Route Up to Date(10)
&
e
oK
Figure 3.1: Creating a new data storage location using the Database Manager
These are the Database Manager tools:
= Database Information: (Figure 3.2) Provides details about the Figure 3.2:
selected database (Database ID, Database Filename, Database H] Database

Information Tool

| 16| "o =D

m| [

Figure 3.3:
Database

Information Window

Tools
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Want to collect
interesting cases in a
single database? Create
» a custom database and
copy patient files using
the patient browser file

transfer functionality.

Add/Link Database: (Figure 3.4) Creates or links a database and adds it to the Sources and
Destination panels.

Rename Database: (Figure 3.5) Edit the selected database name.

Unlink Database: (Figure 3.6) Unlink the selected database from the system and remove it
from the lists in the Sources panel and Destinations panel without deleting all related data
from the system.

Delete Database: (Figure 3.7) Deletes the database from the database list in the Sources
panel, Destinations panel, and all related data from the system. This operation cannot be
reversed.

Update Database: (Figure 3.8) Updates the selected database

Refresh: (Figure 3.9) Updates the current list of the database tables.

E B & & B =

Figure 3.4: Add/ Figure 3.5: Rename  Figure 3.6: Unlink ~ Figure 3.7: Delete Figure 3.8: Figure 3.9: Refresh
Link Database Database Tool Database Tool Database Tool Update Database Tool
Tool Tool

Creating a Local Database for Image Storage

illustrate creating a Training database. Wb ks

1.

data for specific uses. As an example, this guide will

© Favorites

B Computer

Open the Database Manager window from | e
the Tools menu

Select Add/Link Database tool

Create anew File name (see @ Figure 3.10)

File type will remain INVIA Database

(*.icbd) Q e i v eEr—

Select Open to complete the task —
The new database name will appear Figure 3.10: Creating a new database in the patient browser

automatically in the Database Manager

Creating a Network Database for Image Storage

Prior to creating a network database, you will need to insure that the directory on the remote computer

is shared to the network. You also need to insure that the security settings for this directory allows for

remote users to read and write files to this directory. Once sharing and security are defined on the remote

computer:

Nk Wb =

Open the Database Manager window from the Tools menu

Select Add/Link Database

Navigate to the shared directory

Create a new File name (e.g. Training)

File type will remain INVIA Database (*.icbd)

Select Open to complete the task

The new database name will appear automatically in the Database Manager
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CHAPTER 4

SCP vs. SCU

These two terms

are important for
understanding the
communication
capabilities of DICOM
compliant workstations.

A Service Class User
(SCU) is a device that
requests a DICOM
Service, typically a client
requesting information or
data from an SCP.

& A Service Class Provider

(SCP) is the device that
provides the service to an
SCU, e.g. image storage,
image query with image
storage.

The patient browser
provides connectivity for
both of these services.
Databases or folders
saved in the Sources
panel act as SCUs while
databases or folders
saved in the Destinations
panel act as SCPs.

The Station Name will
identify the Corridor
Browser-based SCP
within the network.
This SCP will initially
listen on all available
/ IP addresses. If no IP
address is available,
None will appear as the
IP address and the SCP
service will remain off
until an IP address is
available or defined.

When defining a port,
users should confirm that
the port is not used by

& another network service.
Consult your IT manager
for assistance.

DICOM CONFIGURATION

Upon installation, 4DM Personal will configure a base Service Class Provider (SCP) using the following

parameters:
1. Station Name (by default, this will be the computer’s name)
2. Application Entity (AE) Title (same as Station Name by default)
3. Port # (automatically generated with first available port starting with Port 104)
4. TP address or addresses
5. Data Storage (“Database: Default” is assigned upon installation)

Base SCP Configuration

Initiating the Base SCP

Once 4DM Personal is installed, users must || Base scPconfiouraton
Station Name: READING_ROOM 1P Address:

turn on the Base SCP so Corridor Browser AETHe READING_ROOM  scp s
. . Port, 104 © on @ off
can “listen” for other DICOM workstations. oatastoage

1. Launch 4DM Personal
2. Select Local SCP Configuration
from the Tools menu at the top of

Additional Local SCPs.

. . AE Title Port Location Status
the Corridor Browser interface
3. Inthe Local SCP Configuration
(Figure 4.1) window, verify that
the SCP status is on and click OK e [T
Data Storage: |Database -
All SCPs need the type of file storage defined (e.g.,
database or files). The base SCP will store transferred
files to the default database created at installation.
Customizing the Base SCP Configuration — oo Come )
= In the Local SCP C onfiguration Figure 4.1: The Local SCP Configuration window

window, customize the following

fields in the Base SCP Configuration panel (Figure 4.2):
— Station Name

— AE Title

— Port

—IP

Assigning a Database to

Base SCP Configuration

the Base SCP
Station Name: READING_ROOM 1P Address:
= In the Local SCP AETitle: READING_ROOM  scp status
. - 10 ©o oft
Configuration = ! °
Data Storage:
window, select the
Data Storage drop-
Figure 4.2: The SCP Base Configuration area is the top panel
down menu within the Local SCP Configuration window
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Any changes to the Base
SCP and Additional
Local SCPs will cause it
to automatically stop and
restart. This is a “behind
the scenes” action and
generally takes less than
30 seconds. Any changes
to an SCP should not
occur during data
transfers.

Users can organize files
within the SCP root
folder by selecting a first
and second subdirectory.
Data can be arranged by:

= Patient Name
= Patient ID

= Modality

= Study Date
= None

When defining a port,
users should confirm that
the port is not used by
another network service.
Consult your IT manager
for assistance.

4DM PERSONAL'S PATIENT BROWSER = USER'S GUIDE

= Select Database (Figure 4.3)
= Select the desired database in the second drop-down menu T

— If the default database is the only available option, you can

reference Chapter 3 to create a new database

-

default
Training I

Figure 4.3: Database
selection options

Assigning File Location to the Base SCP

= In the Local SCP Configuration window, select the Data Storage drop down menu in the
Base SCP Configuration panel (top):
= Select Files
= The following fields are now available for edit:
— Root Directory (Browse): Main location of the directory
— 1st Subdirectory: First level of the directory organization
— 2nd Subdirectory: Second level of the directory organization (Figure 4.4)

Data Storage: |Files -

RootDirectory:

15t Subdirectory: | Patient Name -

II

2nd Subdirectory: | Modality

For Example: <=Root Directory=/=Patient Mame=/<Modality=/...

Figure 4.4: Example of the file directory structure

Additional Local SCPs

Creating Additional Local SCPs

= In the Local SCP Configuration window, make the following edits in the Additional Local
SCPs panel (Figure 4.5):
— Enter a unique AE Title and Port #
— Set the Data Storage location
— Turn SCP Status On
— Click the Add tool (Figure 4.6)

Additional Local SCPs

AE Title Port Location Status
AETitle: SmithDffice SCP Status 1
Figure 4.6:
Port: 105 @ On O off
Add Tool

Figure 4.5: The Additional Local SCP area is the bottom panel within
the Local SCP Configuration window.
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When the SCP status

is turned Off, remote

DICOM work stations
& will not be able to

transfer files to Corridor

Browser.

Assigning a Database to an Additional SCP

In the Local SCP Configuration window, make the following edits in the Additional Local

SCPs panel:

— For a new SCP, enter AE Title, Port and Turn on SCP Status (reference Creating

Additional Local SCP’s section above), then continue to next step

— For an existing SCP, select the SCP in the list and continue to next step

Go to the Data Storage drop down menu
Select Database
Select desired database in the second drop down menu

— If the default database is the only available option, you can reference

Chapter 3 to create a new database

+

For a new SCP, click the Add tool (Figure 4.7) and then click OK /

For an existing SCP, click the Edit tool (Figure 4.8) and then click OK

Assigning File Location to an Additional SCP

= For a new SCP, click Add Local SCP and then click OK

Launch 4DM Personal
Select Local SCP Configuration from the Tools menu

Figure 4.7:
Add Tool

Figure 4.8:
Edit Tool

In the Local SCP Configuration window, make the following edits in the Additional Local

SCPs panel (bottom):

— For a new SCP, enter AE Title, Port and Turn on SCP Status (reference Creating

Additional Local SCP’s section above), then continue to next step

— For an existing SCP, select the SCP in the list and continue to next step

Go to the Data Storage drop down menu

Select Files

A new window will open to set the following fields
The following fields are now available for edit:

— Root Directory (Browse): Main location of the directory
— Ist Subdirectory: 1st level of the directory organization

— 2nd Subdirectory: 2nd level of the directory organization (Figure 4.9)

Data Storage: | Files
RootDirectory:

15t Subdirectory: | Patient Name -

{

2nd Subdirectory: | Modality

Browse...

Figure 4.9: Example of the file directory structure

= For an existing SCP, click Edit Local SCP and then click OK

SCP Services

Change the Base SCP Status

Set the SCP Status toggle (On or Off) (Figure 4.10)
Click OK

SCP Status
@ On

i) Off

Figure 4.10: The SCP Status Toggle
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Change an Additional SCP Status

1. Select the Additional SCP to be modified
2. Set the SCP Status Toggle (On or Off)
3. Click the Edit tool

4. Click OK

Deleting an SCP

Users cannot delete the

/ Base SCP; it can only be To permanently remove a custom SCP, select it from the Additional Local ":'__ Figure 4.11:
deactivated (turned off). SCP list, click the Delete (Figure 4.11) tool and then click OK to close the :._ Delete Tool
-
window.
Register SCP Service

For systems using the Windows Firewall (recommended), this button will register the CorridorSCP
application with the firewall. By doing so, the patient browser allows outside computers to query and
store images to the local SCP.

DICOM Node Configuration

The Name field identifies Adding a DICOM Workstation to the Sources and/or Destination Lists

the remote DICOM .

o . = Select DICOM Node Configuration
node within Corridor

/ Browser. Use a unique from the Tools menu
name associated with . Select DICOM node:
= In the DICOM Node Configuration Name AeTe Pagress  Pot Ty

that system (e.g. Camera ) .
Room One). window (Figure 4.12), click the New

tool (Figure 4.13)

= Enter a unique Name in the DICOM
Node Settings window (Figure 4.14)

= Enter the AE Title for the DICOM =
WARNING workstation to which you want to
Remote DICOM connect Figure 4.12: DICOM Node Configuration window

workstations will need

= Confirm that the DICOM Port on the

to be configured to

recognize Corridor remote workstation is 104 (change it if necessary) ﬁ Figure 4.13:
Browser SCPs. Refer to ., f]aﬁﬁ New Tool
the workstation user’s = Enter the DICOM workstation’s IP Address

manual or contact a

= Select the desired Type for the DICOM Node
— Query: Adds the new DICOM Node to the

[ DICOM Node Settngs

service representative for

assistance.
' Sources panel on the Remote tab Name:
® Information necessary
o complete this step — Storej. Afids the new DICOM Node to the AE Title:
includes AE Title, Port #, Destinations panel on the Local and Remote tabs Port 104
d IP add fi h . . . ,
and Hacdress for eac = Click Test to confirm the DICOM connection is IP Address: : ) ]
workstation.
successful Type: (V] Query [#] Store
For more information = Click OK to close the Test window
on remote workstation . . Test oK Cancel
configuration, visit = If passed, click OK on the DICOM Node Settings
www.inviasolutions.com and DICOM Node Configuration windows to save
settings Figure 4.14: DICOM Node Settings
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Editing a Previously Added DICOM Node

= Click the desired DICOM node from the DICOM Node Configuration window (Figure 4.15)
= Click the Edit tool [E oicom tose confunion SN )
= Make the necessary changes on the @/
Select DICOM node: ||
DICOM Node Settings window
= Click the Test tool to confirm the Test Test 123456789 104 QueryiStore

Hame AE Title [P Address

DICOM connection is successful
= Click OK to close the Test window
= If passed, click OK on the DICOM
Node Settings and DICOM Node
Configuration windows to save o)

settings Figure 4.15: Create, edit, delete, and test DICOM Nodes

Deleting a Previously Added DICOM Node

= Select DICOM Node Configuration from the Tools menu
= Click the desired DICOM node

= Click the Delete tool then OK to close the window

The patient browser will enable the user to import a specific image file type (i.e. DICOM, Pegasys,
ECAT) from a Windows directory folder automatically into the local DICOM SCP data storage
location. The files are deleted from the Windows directory folder after the transfer has completed.

How to Configure

1. Select Auto Import from the Tools menu found on the top Menu Bar.
2. Click Browse to navigate and select the Windows directory folder.
3. Select the Data Format for incoming image file types.
=  DICOM - If selected, only DICOM files are read and pushed to the SCP.

= Pegasys — This selection will only read and convert Pegasys formatted image files.
If selected prior to sending to the SCP, the files are converted from Pegasys format to
INVIA DICOM format.

=  ECAT - This selection will only read and convert ECAT 7 formatted image files. If
selected prior to sending to the SCP, the files are converted from ECAT format to
INVIA DICOM format.

4. Select the Data Destination then Add.

The user can remove a Windows directory folder from the Auto Import directory list by clicking
Delete.

Troubleshooting Auto-Import

During the conversion process, a “Pending” folder will be generated within the Auto Import specified
directory folder as a temporary placeholder for files awaiting conversion.

If the conversion process fails, then a “Failed” folder will be created within the Auto Import specified
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Only one file type can be
configured per directory.

& Different image file
formats need to be sent to

separate Windows

directory folders.

directory folder containing the files that failed the conversion process.

If the user is trying to configure an auto import rule and there are not any options displayed in the data
destination drop down menu, the user will need to turn “on” the Local Base SCP Configuration.

Within the patient browser’s Help menu, users can review a record of DICOM activity. The following
logs are available:

= Event Viewer: Records all events and actions for all instances of the patient browser
that are running. This information is used to track potential errors in the operation of the
application which is useful for INVIA to troubleshoot problems with the application.

— Select Event Viewer from the Help menu
— Once the Event Viewer is open, select INVIA from the list to view log entries
— To save the INVIA log to aide in advanced troubleshooting

» Right-click on INVIA

* Select Save Log File As...

= 4DM Personal’s Log Viewer: Provides a real time display of all actions and events
executed by the currently active patient browser. When a problem has occurred with the
application, this tool can help record the specific steps. This tool will be used by INVIA to
troubleshoot problems with the patient browser.
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CHAPTER 5 | DATA MANAGEMENT

4DM Personal’s Patient Browser is designed to provide an interface for DICOM file management. This
section will provide examples of file retrieval and transfer from a variety of sources.

Local to Local

Follow this tutorial to transfer DICOM files from local sources (folders or databases) to local destina-
tions (folders or databases). Refer to Chapter 2 for help creating local sources and destinations.

e

Within the Local tab, click the desired Source so it is selected (e.g., C:\Users\Public\Docu-
ments\INVIA\Corridor4DM\SampleData)
Click the Refresh tool in the Patient List Panel to display a list of patient files

Select files for transfer

(2]

(3]

(4] Click the desired Local Destination so it is selected
elect the Co 0 too

© Select the Copy To tool

(6]

Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete

D B Cotnbace: 362 Turpichsbeiais = Sty Date |1 vn

¢ O LI EEEE

B i o V05 o o oo o Ve § i fiiea §_[wai asae §

@ Figure 5.1: Local to Local Data Transfers
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Local to DICOM (Remote)

Follow this tutorial to transfer DICOM files from local sources to remote destinations. Refer

to Chapter 2 for help creating local sources and Chapter 4 for help creating remote DICOM
workstations.

© Within the Local tab, click the desired Source so it is selected (e.g., C:\Users\Public\
Documents\INVIA\Corridor4dDM\SampleData)

Click the Refresh tool in the Patient List Panel to display a list of patient files
Select files for transfer
Click the desired DICOM (Remote) Destination so it is selected

Select the Copy To tool

@ OO0 0

Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete

[@ itmparurt Wewesmensa ot
Fe Teh el

== [ -
BaE T == W.:.:, __
O B e et Sty . sa | ] e [ e ] e =] El EEtE ]
B 5 Cmmr oG B - )
==+ = 3 = o
0 [ 275 Sl Z
& r % —

e J—

. (5}
N

Figure 5.2: Local to DICOM (Remote) Data Transfers
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In order to transfer DICOM (Remote) to Local

data from a remote . .
workstation to your PC, Follow this tutorial to transfer DICOM files from remote sources to your PC. Refer to Chapter 4 for

& you will need to start the | help creating Remote DICOM sources and destinations and Chapter 4 for help creating additional

default SCP service. Local sources and destinations.
Refer to Chapter 5 for
step-by-step instructions. o Click the Remote tab

@ Select the desired DICOM Source (e.g., DICOM: InterestingCases)

@ Once the data source is selected, click the Refresh tool in the Patient List Panel to display a
list of patient files

@ Seclect files for transfer

© Select the DICOM Destination labeled with your AE Title (e.g., DICOM:ReadingRoom).
This will send the data to the location defined in the Local SCP Configuration

During installation,
the patient browser

/ names the Base SCP @ Select the Copy To tool

with the same name

already assigned to your @ Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete
computer.
[E v oot o=
E,S

el S ”—U@
K@ G)—D'I':‘Tl':a
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3
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=
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s 8 gt b A Lo 5 W Eminn

9 Figure 5.3: DICOM (Remote) to Local Data Transfers
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DICOM (Remote) to DICOM (Remote)

Follow this tutorial to transfer DICOM files from remote DICOM sources to another remote
DICOM destination. Refer to Chapter 4 for help creating remote DICOM sources and workstations.

Click the Remote tab
Select the desired DICOM Source (e.g., DICOM: InterestingCases)

Once the data source is selected, click the Refresh tool in the Patient List Panel to display
a list of patient files

Select the DICOM Destination (e.g., DICOM:Clinic)
Select the Copy To tool

Reference the Job Queue Manager in the Status Bar to confirm data transfer is complete

(1)
(2]
©
@ Select files for transfer
(5]
(6]
(7]

IS

__0
—nl3
.
(5]

SRk Do ety Ao der W Sy,

[ T T obw ¥ Covoleaed Jba 103 Low ok i Scowmn T T
kS Figure 5.4: DICOM (Remote) to DICOM (Remote)
Data Transfers

4DM Personal’s Patient Browser provides the ability to Backup, Restore, [fe Help

Loca Database Manager

and configure Options within Preferences. To access these settings, click

Local SCP Configuration
DICOM Node Configuration

Tools and select Preferences (Figure 5.5) to open the patient browser’s

Job Queue Manager

Preferences

Preferences window.

Auto Import

Backup

The Backup tab (Figure 5.6) enables the user to define e e
a Backup Directory location and specify which options '

to select under Backup Global Settings/Directories and

the Backup Format when performing patient browser’s oo o

Preference Backup. This should be performed after the o S
initial setup of the patient browser.

(o) e

Figure 5.6: Patient Browsers Preferences - Backup
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Restore

The Restore tab (Figure 5.7) enables the user to
specify the directory location of the patient browser’s
Preference Backup using the Restore Directory.
Under Restore Global Settings/Directories, the user
selects from available options contained in the patient
browser’s Preference Backup to restore the patient
browser settings.

Options

The Options tab (Figure 5.8) provides Language
Settings if the user wants to set a language different
from the Windows OS, Patient Display Settings if
the user wants to change the default display level, and
DICOMDIR support for exporting datasets with a
DICOMDIR included.

Badup  Femo | Otors

Rantor Desctory:

Fstars Global Seftings Directanies:

¥] Apphestan Canfgueaton
W] Database Canfguratan
] NGO Mose Cantguaben
| Lecal S8 Cenguation

¥|Fratarance Sattngs.

Figure 5.7: Patient Browser s Preferences - Restore

1B DM Pursoaals Pasint Browsar Prafirances ®

Raciag.  Fastorn [Totors

Language Sesting

Prefemed Language: |05 Bassd -
Patient List Display Settings
Dispiay Lovel | Putert =

¥ Hide Reporing Progerties at Sudy Level

DICOMOR

¥ Enasia DICOMDIR sugan

swe Gance

Figure 5.8: Patient Browser's Preferences - Options
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3025 Boardwalk Drive, Suite 200
Ann Arbor, M| 48108

Tel: (734) 205-1231
Fax: (734) 205-1537
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